PipeLine Software Database Administrator’s Guide
PipeLine Software Database
Administrator’s Guide

The authors' views expressed in this publication do not necessarily reflect the views of the U.S. Agency for International Development or the United States Government.
USAID | DELIVER PROJECT, Task Order 4
The USAID | DELIVER PROJECT, Task Order 4, is funded by the U.S. Agency for International Development (USAID) under contract number GPO-1-00-06-00007-00, order number AID-OAA-TO-10-00064, beginning September 30, 2010. Task Order 4 is implemented by John Snow, Inc., in collaboration with Asociación Benéfica PRISMA; Cargo Management Logistics; Crown Agents USA, Inc.; Eastern and Southern African Management Institute; FHI 360; Futures Institute for Development, LLC; LLamasoft, Inc; The Manoff Group, Inc.; OPS MEND, LLC; PATH; PHD International (a division of the RTT Group); and VillageReach. The project improves essential health commodity supply chains by strengthening logistics management information systems, streamlining distribution systems, identifying financial resources for procurement and supply chain operation, and enhancing forecasting and procurement planning. The project encourages policymakers and donors to support logistics as a critical factor in the overall success of their healthcare mandates.

Recommended Citation

Abstract
This guide will help new and experienced PipeLine users to understand how to set up a PipeLine database, as well as how to perform forecasting, supply planning, and program monitoring with PipeLine. The guide explores the wide variety of programs and settings in which PipeLine is used, and provides advice on ways to manage common supply chain tasks such as forecasting, shipment planning, and program monitoring in PipeLine.

Cover photo: A man on his computer doing work in the West Bank, Gaza Strip.

USAID | DELIVER PROJECT
John Snow, Inc.
1616 Fort Myer Drive, 11th Floor
Arlington, VA 22209 USA
Phone: 703-528-7474
Fax: 703-528-7480
Email: askdeliver@jsi.com
Internet: deliver.jsi.com
# Contents

Acronyms............................................................................................................................................................................. v
Acknowledgments ........................................................................................................................................................... vii
Introduction ........................................................................................................................................................................ 1
  Is PipeLine a Good Choice for Your Needs?.........................................................................................................1
  Purpose ....................................................................................................................................................................... 2
Overview ............................................................................................................................................................................. 5
  Software Structure ....................................................................................................................................................... 5
  Using PipeLine on a Network.................................................................................................................................... 5
Installing and Starting New Files..................................................................................................................................... 7
  Installation Tips ............................................................................................................................................................. 7
  After Installation: The PipeLine Folder Structure ................................................................................................... 9
  Setting Up a New Data File...................................................................................................................................... 11
  Getting Help................................................................................................................................................................. 21
  Quantification in PipeLine...................................................................................................................................... 23
Key Terms......................................................................................................................................................................... 53
Resources.......................................................................................................................................................................... 55
Appendices
  A. Error Messages ........................................................................................................................................................... 57
  B. Frequently Asked Questions .................................................................................................................................... 59
  C. PipeLine Help Request Form................................................................................................................................... 61
Figures
  1. Showing Hidden Files and Folders ........................................................................................................................ 8
  2. Selecting the Installation Location for PipeLine ..................................................................................................... 9
  3. Lead Times in the Shipments Screen .................................................................................................................... 16
  4. Availability/UOM Tab in the Products Screen..................................................................................................... 18
  5. The Quantification Process ..................................................................................................................................... 24
  6. Consumption Data Entered for a 12-month Time Period ................................................................................ 27
  7. Exporting Monthly Forecast Totals ..................................................................................................................... 28
  8. Export to XML Dialogue Box .................................................................................................................................. 29
  9. Selecting the Output Destination.......................................................................................................................... 30
  10. Export Confirmation Screen .................................................................................................................................. 31
<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABBEF</td>
<td><em>Association Burkinabé pour le Bien-Etre Familial</em></td>
</tr>
<tr>
<td>AMC</td>
<td>average monthly consumption</td>
</tr>
<tr>
<td>BU</td>
<td>basic unit</td>
</tr>
<tr>
<td>CYP</td>
<td>couple-year of protection</td>
</tr>
<tr>
<td>DGPS</td>
<td>Health Program General Directorate</td>
</tr>
<tr>
<td>FHD</td>
<td>Family Health Directorate</td>
</tr>
<tr>
<td>MOH</td>
<td>Ministry of Health</td>
</tr>
<tr>
<td>MOHCW DPS LSU</td>
<td>Ministry of Health and Child Welfare Department of Pharmaceutical Services</td>
</tr>
<tr>
<td></td>
<td>Logistics Supply Unit</td>
</tr>
<tr>
<td>MOS</td>
<td>months of supply</td>
</tr>
<tr>
<td>PDF</td>
<td>portable document format</td>
</tr>
<tr>
<td>SCMS</td>
<td>Supply Chain Management System</td>
</tr>
<tr>
<td>SDP</td>
<td>service delivery point</td>
</tr>
<tr>
<td>USAID</td>
<td>U.S. Agency for International Development</td>
</tr>
<tr>
<td>XML</td>
<td>extensible markup language</td>
</tr>
<tr>
<td>ZISHAC</td>
<td>Zimbabwe Information System for HIV/AIDS Commodities</td>
</tr>
</tbody>
</table>
Acknowledgments

Many people contributed their time and expertise to this administrator’s guide. Lisa Blankenship, Jeff Leiner, and Ashraf Islam provided invaluable insight into the program’s inner workings and explanations of some of the more technical functions. Robert Burn at the Supply Chain Management System (SCMS) project gave helpful guidance about topics to be addressed and suggested staff in the field who could contribute to the review. Marie Tien coordinated and wrote the country case studies. From USAID | DELIVER PROJECT and SCMS field offices, we thank Bernardo Uribe (in Paraguay), Parfait Edah (in Burkina Faso), Wendy Nicodemus (in Zambia), and Chester Marufu and Dimitri Peffer (in Zimbabwe), for their time and efforts in telling us how PipeLine is used in their countries.

Field and headquarters staff from the USAID | DELIVER PROJECT and SCMS also provided comments on the draft guide, adding their own experience and expertise along the way. In Washington, DC, helpful insights and commentary was provided by Greg Roche. In Nigeria, Innocent Ibegbunnam and Tunji Odeola gave valuable advice on the organization of the guide.

Finally, we thank our colleagues at the U.S. Agency for International Development, especially Lindabeth Doby and Alan Bornbusch, for their support and constructive review as we worked to enhance our colleagues’ experience and knowledge of PipeLine.
Introduction

Ensuring adequate supplies of commodities is a challenge for most programs. You need to monitor the quantity and timing of multiple products entering your logistics system from multiple suppliers. Because procurement lead times may be long—years, in many cases—you need to take action months or years before commodities are needed to receive them on time.

The Pipeline Monitoring and Procurement Planning System (PipeLine) was designed to help program managers monitor the status of their product pipelines and product procurement plans. PipeLine provides information needed to ensure the regular and consistent stock of products at the program or national level. Consistency of stock is the first step in meeting the basic objective of any logistics system and ultimately providing products to clients.

For each product, PipeLine monitors—
1. total quantities consumed (i.e., amounts dispensed to users or sold to clients)
2. shipments of new products (planned, ordered, shipped, or received) into your program and the values of your products
3. inventory levels for each product in your program’s logistics system (desired and actual)
4. inventory level changes (e.g., product losses or transfers out of or into your program).

With these data and an understanding of the lead time required for each step in the procurement process, PipeLine can—
1. show what actions you need to take for procurement planning and management, and when these actions should be taken
2. identify impending problems (i.e., surpluses, shortfalls, or stockouts) before they occur
3. calculate procurement quantities needed to keep your pipeline in balance
4. calculate the estimated value of shipments or maintain the actual value (if known).

You can use this information with program policymakers, product suppliers, and donors to provide a rational basis for planning future product needs. PipeLine’s utility is enhanced if your program has a well-functioning logistics management information system and established forecasting procedures. Even without these underlying systems, you can use PipeLine with whatever data are available. By beginning a rational and systematic product monitoring and planning process, you take the first step toward ensuring consistent stock levels.

Is PipeLine a Good Choice for Your Needs?

PipeLine’s core strength is as a supply planning and monitoring tool for a whole program. PipeLine does not monitor the flow of products between supply chain levels or facilities. Instead, it monitors the amount of product in the entire program at once, from the lowest to the highest level.
Whether or not PipeLine is a good choice for your program depends on the tasks you wish to accomplish. The needs expressed in Table 1 are beyond PipeLine’s scope and best filled by other software/programs.

**Table 1. Logistics Tasks Outside PipeLine’s Scope**

<table>
<thead>
<tr>
<th>If you need to…</th>
<th>Look for software that…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor operations at a single level of a supply chain or a single facility, such as a central warehouse or service delivery point</td>
<td>Tracks products by lot and expiration date, such as a warehouse management system</td>
</tr>
<tr>
<td>Track shipments between facilities or levels in a supply chain</td>
<td>Can aggregate and disaggregate data by facility type and level, and record shipments to individual facilities separately</td>
</tr>
<tr>
<td>Monitor financial accounts, stock balances, and human resources in one system</td>
<td>Can incorporate all those elements, such as an enterprise resource planning system; note that such systems are often costly and require significant planning and resources</td>
</tr>
</tbody>
</table>

Some programs have used PipeLine as a check on central warehouse stocks; however, it is important to note that in this situation, PipeLine is not being used exclusively to manage those stocks. It is used only as a check on stock level calculations where there is a question about the accuracy of the data collection or system in place at the warehouse.

**Purpose**

The *PipeLine Database Administrator’s Guide* is intended to fill a gap in the existing documentation for PipeLine software. It describes typical use of the software in a program environment, including both *how* to accomplish tasks such as forecasting and *why* those tasks are performed in specific ways in PipeLine. Case studies of PipeLine use in various countries are provided, and the software’s features and limitations are described in greater detail.

Companion documents that should be used in conjunction with this guide include—

- *The PipeLine 4.0 User’s Guide (2007)*: provides basic description of each of PipeLine 4.0’s features and step-by-step instructions for using each feature
- *New Features and Existing Issues in PipeLine 5.1 (2011)*: this short insert identifies new features included in an upgraded version of PipeLine 5.0 and addresses issues with various operating systems and versions of Microsoft Office software, which were unresolved at the time PipeLine 5.1 was released.
Together with this administrator’s guide, these three documents provide a complete description of PipeLine 5.1, its features, and how to use it.

**Document Organization**

The administrator’s guide is organized into the following sections:

- **Introduction** familiarizes users with the guide and defines its purpose and intended audience.
- **Overview** provides a summary of the way the software functions and how it is structured from a non-technical (e.g., non-programmer) perspective.
- **Installing and Starting New Files** provides tips for installing PipeLine, shows locations where PipeLine installs on various operating systems, and provides guidance for setting up an initial database file.
- **Usage Guidelines** discusses the various ways in which PipeLine may be used, and highlights innovative approaches to using PipeLine from USAID | DELIVER PROJECT field offices and partners.
- **Key Terms** defines key terms and known issues, and provides references to other documentation that readers of this guide may find useful.
- **Appendix A** contains explanations of common error messages and **Appendix B** includes a frequently asked questions section.

**Intended Audience**

The intended audience for this administrator’s guide is those who will be using PipeLine on a daily, weekly, or monthly basis; those who will be managing data for programs; and especially those who will be setting up PipeLine databases for the first time. The guide explores issues that regular users of PipeLine will commonly deal with and highlights creative uses of PipeLine software around the world.
Overview

PipeLine is designed to be useful for both large and small programs providing virtually any product, even in environments where online networks and large, computerized information systems are not available. For this reason, it remains a simple Microsoft Access desktop application. The sections that follow explain in greater detail what kinds of program products PipeLine can effectively manage, how the software files are set up on your computer, and the types of computing environments where PipeLine can be used.

Software Structure

PipeLine consists of two main elements: a “front end” Microsoft Access application and a “back end” database. The front end provides the structure for the data, displays data, and manages functions you use in PipeLine to manipulate the data (for example, the Consumption Screen or the Stock Status Report screen are both elements of the front end). The back end is where the actual data in your databases are stored. Similar to other Microsoft programs like Word, you can have multiple databases opened by the same front end program.

For example, if you manage two different health programs with PipeLine and choose to create a separate database for each program, you will have two separate databases for those programs. As the back end and front end are separate pieces, you can have multiple databases open at the same time in PipeLine (similar to the way you might have two or three documents open at the same time in Microsoft Word) and switch between databases to view their data while they are open.

Unlike Word, however, when you close PipeLine, it “remembers” which files you had open and reopens them when it restarts. In order to open PipeLine, you must always have at least one database open. If you do not, PipeLine will prompt you to open a database. A sample database, “Global Ministry of Health” is provided with each installation of PipeLine, and it resides in the same location as the front end, on your C drive.

Keep the sample database open at all times to avoid delays when starting PipeLine.

Using PipeLine on a Network

PipeLine is designed to be a desktop application, meaning it is designed to run by itself from a single computer’s hard drive. It does not require a connection to the Internet or a network for any of its functions.

It is certainly possible to use PipeLine in a networked environment, and many programs around the world do. This means that the database (the back end) resides on a server that is connected to multiple desktop computers, rather than on a single desktop. (PipeLine’s front end lives on your C drive—it is not designed to be installed on a network. Each PipeLine user must have the software installed on his or her desktop in order to use PipeLine.)

There are important caveats to working on PipeLine databases in a networked environment. Multiple users can use the files if they are connected to the server location where the data are stored,
and they can even work on a single data file at the same time; however, they will not know that another user is viewing and manipulating the file. If two or more people are using a data file at the same time, there is a possibility that they could overwrite one another’s changes without knowing it. You also cannot identify which user last made changes to the database. In the Usage Guidelines chapter of this guide, you will find case studies describing how some other PipeLine users have managed databases saved on network drives and accessed by multiple people.
Installing and Starting New Files

If you are setting up a new installation of PipeLine for the first time, you need to know where PipeLine resides on your computer and where you will save your databases. The following sections describe where PipeLine installs on commonly used operating systems and the default folder structure for PipeLine databases.

Installation Tips

The PipeLine front end (the actual software) installs in different locations on your C drive, depending on which operating system you are using. At this time, PipeLine has only been tested on personal computers using Microsoft operating systems. It has not been tested or programmed for Mac, or other operating systems such as Linux.

You can accept the default location where PipeLine installs on your operating system or you can choose a different location. Choosing a different location may result in problems using PipeLine and is not recommended. See the section “Choosing the Installation Folder Yourself” for guidance.

Windows 7 and Windows Vista

In Windows 7 and Windows Vista, PipeLine installs at the file location:

C:\ProgramData\PipeLine

Both the software files (the front end) and the databases (the back end) will be located in this folder.

Windows XP

In Windows XP operating systems, PipeLine installs at:

C:\Documents and Settings\All Users\Application Data\PipeLine

You may not see the “Application Data” folder immediately if you look for this file path on your computer. That is because the Application Data folder is sometimes hidden, depending on how your system is set up. To see the folder, open Windows Explorer, go to Tools > Folder Options > View, and select the radio button “Show Hidden Files and Folders” (see figure 1).
Choosing the Installation Folder Yourself

You may wish to choose where PipeLine installs on your machine rather than accepting the default installation locations (which are dependent on your operating system). We do not recommend this because it may cause errors while using PipeLine. If you choose to install in a different location, however, before you start you must create a new folder where PipeLine can install itself, as described subsequently.

Creating the PipeLine Folder

When PipeLine installs in a default location, it automatically creates a folder called “PipeLine” where all files related to the front end are stored. If you choose a location other than the default location, you must create this folder yourself. If you do not, PipeLine will not function properly on your machine. It is important that the new folder is named “PipeLine.” If you call it something else, PipeLine will not function properly on your computer.

After creating the PipeLine folder, begin the PipeLine installation process. At the prompt shown in figure 2, navigate to the PipeLine folder that you have just created and direct the installer to continue installing PipeLine there.
After Installation: The PipeLine Folder Structure

Wherever PipeLine installs on your C drive, it creates six folders that contain specific types of data. Some folders are created for your convenience, and others store basic items, such as icons, that PipeLine uses on your machine. You can choose to store data in these folders, create new folders, or ignore them. The six folders are—

1. ANYMOH
2. Data
3. Graphics
4. Import
5. Summary
6. XML.

ANYMOH Folder and the Kammanland Data File

This folder contains the database “globalmoh.mdb,” a database for the fictional country of Kammanland. This is the sample file provided with PipeLine, which we also referred to in part 2 of this guide (“Software Structure”). In PipeLine, you must always have at least one data file linked to
the front end; we recommend keeping the sample data file linked at all times to avoid delays (caused by prompts to open a database) when operating PipeLine.

The Kammanland data file is also useful as a test file. It contains a small set of imaginary data, which you can use to familiarize yourself with PipeLine and to try out any features that you might like to explore without the possibility of changing your own actual data file.

**Data Folder**

This is the default folder where PipeLine saves databases. It is provided for your convenience, but you do not need to save databases here if you prefer to save them somewhere else. When you select File > Open from the File drop-down menu in PipeLine, it will always automatically open this folder. If you have saved your databases elsewhere, simply navigate to the location where your files are saved and open them from there.

**Graphics Folder**

This folder contains graphics for PipeLine, such as the icon that sits on your desktop after PipeLine is installed. Do not delete this folder.

**Import Folder**

The import folder is provided for your convenience, and it is a place where you can store files you might import into PipeLine, such as databases from Quantimed software or Supply Chain Manager software. You need not store files here if you do not wish to.

**Summary Folder**

This folder contains files for PipeLine Summary, a part of the PipeLine application. PipeLine Summary allows you to compare selected data from two different databases side by side. This feature has not been updated recently, however, so its functionality is limited. For more information about PipeLine Summary, please see section 8 of *The PipeLine 4.0 User's Guide*.

**XML Folder**

This folder contains two sample files in a format called XML, or extensible markup language. XML is a data exchange format that allows data from one program (such as Quantimed) to be imported and read by another program (such as PipeLine). You can store other XML files that you import into PipeLine in this folder, or you may ignore it if you wish to store them elsewhere.

The two sample files included in the folder are product catalog files that you can use to import product information into PipeLine. One is a sample file for

---

**Sample XML Files**

If you are working with family planning products supplied by the U.S. Agency for International Development through the USAID | DELIVER PROJECT, or antiretrovirals, test kits, and laboratory supplies supplied through the Supply Chain Management System (SCMS) project, you can use the sample XML files supplied in the XML folder to import products into your data file.

Importing products using the sample files will cause certain fields (such as the product name and product code) to be greyed out, meaning you will not be able to alter them after the import. These fields become inaccessible so that the product information may be more easily updated with XML files produced centrally by either the USAID | DELIVER PROJECT or SCMS in the future. If you think you may need to change the product name or code in the future, manually enter the products instead of importing them.
contraceptives supplied by the U.S. Agency for International Development (USAID) through the USAID | DELIVER PROJECT. The other file is a sample file of products supplied by USAID through the Supply Chain Management System (SCMS) project. (For more information on importing different types of data, see section A-2 in The PipeLine 4.0 User’s Guide. The box “Sample XML Files” describes some considerations for using the files found in the XML folder.)

**Modifying the XML Files**

It is possible to modify the XML product catalog files and customize them to your own products and program if you wish. To do this, you will need some knowledge of XML and the schema for the files. The schema can be found in the PipeLine 5.1 Technical Documentation, in the “Interfaces with Other Systems” section, which is available from the USAID | DELIVER PROJECT.

Although it is not strictly necessary, it is much easier to edit the files in software that is made specifically for editing XML. Even if you modify the files, you will still be subject to the same constraints on the product code and product name fields after you import (in other words, you will not be able to change the product name or product code of an imported product—those fields will be locked).

**Setting Up a New Data File**

There is no one “correct” way to begin populating a new PipeLine data file; however, starting a new file with an understanding of what you want to store in it, collecting a few basic data items, and knowing which fields require data will make the process faster and will ultimately save time.

**How Many Databases Will You Need?**

Depending on the number of health programs being managed in PipeLine, and the number and types of products used by each program, it may be advantageous to create more than one data file. To help you decide if you need more than one data file, consider the information in Table 2.

**Table 2. Factors to Consider When Setting Up Multiple Databases**

<table>
<thead>
<tr>
<th>Consider a single database if…</th>
<th>Consider multiple databases if…</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have multiple programs with just a few (e.g., 10 or fewer) products each</td>
<td>You have a single program with more than 50 products, or have multiple programs with many products (e.g., 20 or more) in each program</td>
</tr>
<tr>
<td>Your program or programs’ data can be safely shared among stakeholders of all programs involved</td>
<td>You need to share databases with stakeholders of multiple programs who should not (or do not wish to) see each other’s data</td>
</tr>
<tr>
<td>You have multiple programs that are related in some way, and for which it may be advantageous to see products in each program together in graphs and reports (you can use PipeLine’s Categories function to organize them)</td>
<td>You have multiple programs that are managed separately; consider separating them especially when there will be different staff managing each data file</td>
</tr>
</tbody>
</table>
The “size” of the program (e.g., localized to a specific geographic area or national in scope) is not important in deciding how many databases to create. PipeLine is designed to monitor programs of all sizes. The number of products and shipments in the program will have a far greater impact on the day-to-day operations of the database than the scope of the program. The quantity of each product moving through the program is also unimportant to the decision to create a single file or multiple databases. High-quantity products and low-quantity products can easily coexist in the same database.

The number of years of program data that you have is only important as a function of the number of products that you have. Even if you have multiple years of historical data for only a few products, they can easily be entered into a single data file without compromising database performance. When you have multiple years of historical data for more than 20 products, however, consider multiple databases.

PipeLine can be used to monitor any type of product that you wish. Although it was originally designed for contraceptives, it is now used with essential medicines, malaria products, laboratory supplies, consumables, and many other items. The following case study from Zambia shows how programs in that country have organized multiple PipeLine databases to manage a complex system of parallel and overlapping supply chains for six product types.
PipeLine Case Study: Zambia

In Zambia, PipeLine is used to manage a large number of health commodities, including contraceptives, antiretrovirals, HIV test kits, malaria commodities, essential medicines, and laboratory commodities. For practical purposes, there are separate PipeLine databases for each of the six product types. Laboratory commodities currently have two databases. Antiretrovirals and HIV test kits have multiple databases to track supplies both from the service delivery point (SDP) level and multiple supply chains.

Three PipeLine Databases for Antiretrovirals in Zambia:

1) Medical Stores Limited: monitors stock levels at the central warehouse
2) Churches Health Association of Zambia (CHAZ) warehouse: the database contains CHAZ managed stock (CHAZ runs a parallel antiretroviral distribution system)
3) SDP level: the database monitors stock levels throughout the system and is used for aggregated national stock monitoring as well as forecasting.

Managing Multiple Databases

The field office has set up procedures and processes to ensure the smooth administration of PipeLine. Under the office’s monitoring and evaluation team, an advisor is specifically responsible for overseeing the quality assurance of all quantification activities, which includes monitoring of the PipeLine databases. The advisor develops and documents standard procedures to be utilized across all of the teams. There are six different teams managing the PipeLine databases, for a total of 30 people involved in the management of PipeLine. Within each team, a team member is responsible for updating the database. After that team member conducts an initial review, the team meets to review the database together. To avoid duplication and overwriting changes, only one person updates the database at a time. In terms of file management, the new database is saved in a public folder accessible to all on the project office’s server each time a database is updated, and the old database is placed in an archived folder. On a monthly basis, the updated databases are shared with the Ministry of Health (MOH) and appropriate key partners. To distinguish files from one another, the files are given a unique identifier, including the date and product type.

PipeLine is updated when orders are received, varying from a daily to weekly basis. Warehouse issues, stock on hand, shipments received, and losses and adjustments are provided from the central warehouse for approximately 30 antiretrovirals, three HIV tests, eight malaria commodities, over 100 essential medicines, and over 200 laboratory commodities on a monthly basis. For approximately 30 antiretrovirals, three HIV tests, and over 185 laboratory commodities, consumption, stock on hand, and losses and adjustments data at the SDP come from the supply chain manager database at the central warehouse. After installation of the MACS warehouse management system in 2007, the transmission of data has become quicker and more timely.

PipeLine Data Informs Quantification

PipeLine’s ability to calculate when shipments are needed to keep stock levels in balance, as well as reports to show trends and issues, make it a valuable tool to make effective management and planning decisions. The Zambia office uses PipeLine extensively during each step of the forecast and quantification process. The quantification teams, led by the MOH with significant support from the USAID | DELIVER PROJECT and Supply Chain Management System project, review the stock status report, consumption graph, and problem reports generated from PipeLine. The problem reports can help identify potential over- or understocks in the future due to changes in consumption that should be taken into consideration for the forecast. The quantification team uses these reports to generate an initial forecast after which the teams review trends in past consumption to compare them with the forecast to determine if the forecast makes sense. Once the forecast is agreed on, the teams use PipeLine to develop the procurement plan. The MOH, donors, and partners are then brought together to decide who will pay for the planned shipments based on the funding they have available. PipeLine’s Shipment Summary report is used to identify funding gaps when all known funding has been allocated. This information is essential to advocate for additional funding.

In Zambia, PipeLine is used during the MOH-led quarterly quantification review meetings for each of the product types where the forecast is reviewed against actual consumption using the Stock Status and Consumption graphs. Based on any changes in consumption, the procurement plans are subsequently reviewed and adjusted to ensure shipments are received in time to keep the pipeline in balance.
Preparing Program and Background Data

Before creating a new data file, collect information for the background data sections to make the data entry task easier (see sections 3 and 4 of *The PipeLine 4.0 User’s Guide* for step-by-step instructions on entering program and background data into a data file). When you open a new data file, you will need to enter information into the Program Data screen (the first screen you will see), and the Products, Suppliers, Categories, and Data Sources sections under Background Data. The following discusses the key data items in each section that you must have entered before you can enter stock, shipments, and consumption data.

Essential Program Data Items

We recommend that you fully populate every field in the Program Data Screen in order to describe the program and give users information about who is managing the database should they have questions. However, there are several essential fields you must fill in on the Program Data screen in order to use PipeLine’s full functionality. It is helpful to have this information on hand before you create a new database. The essential fields are as follows:

1. **Program Name**: what the program will be called in all printed reports from PipeLine. Note that it is different from the file name, which is what you will see when you select File > Open to view the data file in PipeLine.

2. **ISO Country Code/Report Display Name**: the country in which the program is located.

3. **Program Code**: the Program Code field must contain a unique program code for every data file. The code can be up to 10 characters, and may contain numbers and letters.

4. **Language**: PipeLine 4.0 and PipeLine 5.1 are available in multiple languages. Choose the default language in which you want to view data here.

5. **Default Lead Times**: the lead times are the number of months between planning and ordering, ordering and shipping, and shipping and receiving products. (Shipping to receiving lead times should include time needed for customs clearance or other in-country procedures. See page 3-3 of *The PipeLine 4.0 User’s Guide* for step-by-step instructions.) They will be applied as default lead times for suppliers (who provide the products) in the Suppliers section of your data file. You can modify the lead times for individual suppliers if the default lead times are not accurate for a particular supplier. If you have multiple suppliers, use the lead times from your most frequent supplier to populate these fields.

   a. If you do not know what your lead times are, you can check with the suppliers themselves to get information on the order-to-ship and ship-to-receive lead times. The
plan-to-order lead time, however, will be partially determined by your program. If you do not know it, consider—

i. how long it typically takes between the time a shipment is planned and the time it is ordered

ii. if any approval processes must occur before a planned shipment can be ordered, and how much time those processes require.

6. Default Freight Cost: the default freight cost is a default value for the entire program, expressed as a percentage of the shipment’s overall value and including all associated fees. If you are not sure what your default freight percentage is, you can—

a. check with your default supplier of products and ask for their freight percentage

b. review recent shipment costs and calculate an average freight percentage.

---

**How Default Lead Times and Freight Costs Affect Your Data**

The default lead times and freight costs shown on the Program Data screen will be applied to each supplier in your data file, unless you manually change them to match the individual supplier’s lead times (you can do this in the Suppliers screen) or freight costs. For any supplier to which they are applied, they will be used to calculate actual dates for planning, ordering, and shipping products and estimated shipping costs.

For example:

You schedule a shipment to be received on April 4, 2012, from Supplier X. When you entered information about Supplier X in the Suppliers screen, you chose to leave the default lead times as the lead times for Supplier X. Those lead times are:

- Plan-to-order: six months
- Order-to-ship: four months
- Ship-to-receive: two months

In the Shipments screen, PipeLine calculates the following dates based on the lead times for Supplier X. In order to be received by April 4, 2012, you must:

- Plan your order by: February 4, 2011
- Place your order by: October 7, 2012
- Your order will ship on: February 4, 2012

For an example, see figure 3.
Essential Background Data Items
Background data is described in more than one screen in PipeLine—it includes descriptions of products, suppliers, and funding sources of your shipments. There are several other background data items that, while not essential to PipeLine’s function, will greatly enhance its usability. We suggest that all these data be compiled and ready to enter before you create a new database. Step-by-step instructions for adding all data in the Background Data portion can be found in chapter 4, “Background Data,” of The PipeLine 4.0 User’s Guide. The following paragraphs describe which data are essential for using PipeLine and which are non-essential (but very useful to have).

Products—Essential Data
If you import your products from one of the sample XML lists included with PipeLine’s installation, most of these fields will already be filled in for you. If you manually enter products, for each product, you must fill in the following:

- Product Name
- Product Code
  - The Product Code can be anything you wish, up to 10 characters.
- Default Supplier
- Months of Stock for the Program (All Levels), including maximum, minimum, and desired stock
  - Note that the Central Level maximum and minimum are for your information and records. They do not affect calculations in PipeLine.

What is Desired Stock?
The term “desired stock” may be new to you. If you use PipeLine’s shipment planning functions, when you automatically plan a shipment it will be calculated to bring stock levels up to your desired stock, not your maximum. Why would your desired stock be different from your maximum? It might not be different if you have one location where you receive shipments when they arrive in-country (or program). However, the maximum is the absolute most that your inventory system can hold of any particular product in the entire country/at all levels. Ordering to maximum for every product assumes that your forecast has no error at all (which is impossible). If there is any error in the forecast, then ordering to maximum will actually risk putting your stocks over maximum. It may therefore be to your advantage to hold less than the maximum, and if so, you can set the desired stock level lower than the maximum. (You can also set it equal to max if you prefer.) In PipeLine, we suggest a formula for calculating desired stock as:

\[(\text{Min} + \text{Max} + \text{Order Interval}) / 2\]
For a thorough discussion of setting maximum and minimum for your program, see chapter 4 of *The Logistics Handbook* (USAID | DELIVER PROJECT 2011c).

What happens if you do not have a maximum/minimum set for your program? Although PipeLine is designed to operate within the context of a maximum/minimum inventory control system, it is possible to use it without having maximum and minimum set. However, using PipeLine without a maximum/minimum will render certain reports and features less useful. In particular, these include—

- the Stock Status Graph (which relies on the input maximum and minimum to show where stocks fall between those two values)
- the Stock Status Report (which relies on the input of maximum and minimum to show quantities of shortfall or surplus, in order to maintain an adequate supply of a product)
- automatic shipment planning from the Stock Status Report, which requires a desired stock level (in months of supply [MOS]) in order to calculate shipment quantities.

**Products—Useful Data**

These data items, found in the products screen, are not essential but are extremely useful. Entering the data described as follows will provide the best functionality in PipeLine.

When you enter product consumption and shipment data into PipeLine, you will do this in packs, so it is important to define what you consider to be a pack. Basic units (BUs) are the smallest unit of the product that you wish to count. They are included in PipeLine because programs working with some medicines (such as antiretrovirals, tuberculosis treatment programs, and others) will forecast and collect consumption data in tablets or milliliters according to the number of treatments that must be provided. If you are working with these types of products, you may find it useful to be able to see consumption and shipments in both BUs and packs. If you have input the proper pack size and BU into PipeLine, it can tell you consumption and shipment quantities in either packs or BUs in several different graphs and reports.

Useful fields in the Products screen are—

- default quantity per case: this is the number of packs per case
- type: this is the category for the product, such as Contraceptive. For step-by-step information on how to enter categories, see pages 4-11 to 4-14 of *The PipeLine 4.0 User’s Guide.*
- Under the “Availability/UOM” (unit of measure) tab in the Products Screen (see figure 4), the pack size and BU fields define how many units per pack, and what those units are. Table 3 gives some example pack sizes and units of measure.
Figure 4. Availability/UOM Tab in the Products Screen

Table 3. Examples of Pack Sizes and Units of Measure for Products

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Pack Size</th>
<th>Unit of Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male condom</td>
<td>1</td>
<td>Piece</td>
</tr>
<tr>
<td>Combined oral contraceptive pill</td>
<td>1</td>
<td>Cycle</td>
</tr>
<tr>
<td>Long-lasting insecticide-treated bed net</td>
<td>1</td>
<td>Piece</td>
</tr>
<tr>
<td>Fluconazole 200mg/tablet</td>
<td>1</td>
<td>Tablet</td>
</tr>
<tr>
<td>Fluconazole 10mg/mL bottle of 35 mL</td>
<td>35</td>
<td>mL</td>
</tr>
<tr>
<td>Ceftriaxone 1 mg powder for injection, 10 vials</td>
<td>10</td>
<td>Vials</td>
</tr>
<tr>
<td>Ciprofloxacin 500mg, 100 tablets (10 x 10 blister pack)</td>
<td>100</td>
<td>Tablets</td>
</tr>
</tbody>
</table>

- The Note and Preference Note tabs are provided for your convenience. You can store any information here about the product that you wish. Notes provide insight to others that may review the PipeLine database on your rationale for choosing certain parameters as part of the background data and also remind users of assumptions made in the past.

Case Sizes
You may have one product supplied by multiple suppliers and in different case sizes. In the case sizes screen, you can specify a different case size for each supplier. Case sizes have effective dates. If you are entering historical data into your database, the case size assigned to specific shipment will depend on the effective date assigned to the case size when you enter it. If your case sizes have changed over time, be sure the effective date is correct for each case size so that historical shipment information is accurately recorded.

What if one supplier has a product that currently comes in multiple case sizes? In this instance, you could create multiple products—one for each case size. You may also consider ignoring case sizes, if creating multiple, similar products with different case sizes may generate confusion. Instead, count the products in packs.
Costs
Costs in PipeLine refer to a per unit (per pack) cost in U.S. dollars. Similar to case sizes, different costs can be assigned to different product-supplier combinations. Costs are important data items that can be used to further describe the shipment data you enter in PipeLine as you build your database. Per unit cost is used in two specific calculations in the Shipments screen and associated reports:

1. When you enter shipments in PipeLine, the per unit cost for the specific product you are shipping is multiplied by the number of packs in the shipment to calculate the cost of the product being shipped.
2. The total product cost is multiplied by the freight percentage for the shipment’s supplier to calculate an estimated freight cost for the shipment.
   a. Total product cost and estimated freight cost are added together to estimate the total cost of the shipment.

Like case sizes, costs also have an effective date. If you are entering historical shipment data and your product costs have changed over time, be sure to enter the appropriate effective date for each new cost so that PipeLine calculates your shipment costs correctly.

If you have a single supplier with multiple costs for the same product (e.g., different costs for different packaging), enter two products (one product for each type of packaging).

Categories
The Categories screen is one of the most useful (and often overlooked) features in PipeLine. As the name implies, you can categorize different products in your database in a wide variety of ways. Categorizing products enables you to view products under the same category as a combined entity in graphs and reports, adding their consumption and stock totals together. Categories themselves are organized in a hierarchy. You can see this hierarchy visually by clicking on the “View Categories” option in the Tree View menu on the left side of the screen. In each new database, sample categories are already included. Delete them (except the top-level parent “All Categories”) if they do not apply to your program.

A category with more than one product assigned to it is referred to as a “Type” throughout PipeLine. Having products categorized into Types can be especially valuable in viewing graphs and reports.

The kinds of categories you include in your database will depend on what products you plan to manage. Even if you set up multiple PipeLine databases for different types of products, you may still wish to categorize products inside those databases. How you categorize them is up to you and your needs. As a general rule, include two or more products in one category if you need to see them added together in a graph or report. When you view a graph or report in PipeLine by Type, you will see a list of categories that are assigned to two or more products in your data file. The graph or report will display

When is a Category a “Method”?
On the right side of the Categories screen is a check box next to the word “Method.” Beneath the check box is a field called CYP Factor. If your database includes contraceptives, you can use these two fields to designate a couple-year of protection (CYP) factor for each contraceptive method. (You will notice that each new database includes several contraceptive methods as default categories, such as injectables or male condom.) To designate a category as a method of contraception, select the category and check the Method box. Then enter the appropriate CYP Factor for that method. If you are not monitoring contraceptives in your database, leave the Method box unchecked and ignore these fields.
consumption and/or stock totals for both products added together. If shipments are included in the
report, shipments for all products under that category will be displayed.

Each category should have a parent category. For top-level categories, the parent category will be
“All Categories,” which should be the top-most category in any database. When setting up your
database, it is advisable to categorize all your products as you enter them (see table 4 for examples of
product categorizations).

Table 4. Examples of Product Categorization

<table>
<thead>
<tr>
<th>Program and Product Description</th>
<th>Possible Categorization</th>
</tr>
</thead>
<tbody>
<tr>
<td>A single program carrying multiple brands of male condoms and female condoms, each with distinct characteristics</td>
<td>Parent category: condom</td>
</tr>
<tr>
<td></td>
<td>Subcategories: male condom, female condom</td>
</tr>
<tr>
<td>Two programs, one for pediatric HIV and AIDS therapies, the other for adult HIV and AIDS therapies, which are combined in the same data file</td>
<td>Parent category: antiretroviral</td>
</tr>
<tr>
<td></td>
<td>Subcategories: pediatric, adult</td>
</tr>
</tbody>
</table>

Suppliers

Suppliers are the donors or other entities (such as the Ministry of Health) who provide products
and, specifically, who ship the products to your program. If you purchase products directly from a
manufacturer, then the manufacturer could also be designated as a supplier.

When you create a new database in PipeLine, the Suppliers screen will already include a few
suppliers by default, such as the USAID | DELIVER PROJECT. If these suppliers are not relevant
to your program, you may simply delete them. (You will not be able to delete them if any shipments
have been assigned to them, however.) You could also modify them, if your lead times or default
freight costs are different. As with the default lead times and freight cost on the Program Data
screen, if you do not know the lead times or freight cost for a particular supplier, you can contact
the supplier or analyze any historical shipment information you have available.

For each individual supplier, record—

- plan-to-order lead time (in months)
- order-to-ship lead time (in months)
- ship-to-receive lead time (in months)
- freight costs as a percentage of total shipment value

- The default lead times and freight cost that you entered on the Program Data screen will be
automatically entered for any new supplier. You can change them manually for each supplier to
reflect the individual supplier’s lead times and costs.

- You may select one supplier as the default supplier for your program by checking the “Default”
box at the bottom of the screen. Whenever you enter a new shipment, the default supplier will
be automatically assigned to that shipment (but can be changed manually if appropriate for a
particular shipment).
**Data Sources**

Data sources are the places where you obtain data for your program for—

- actual consumption (e.g., your logistics management information system could be a source for this information)
- forecast consumption (e.g., a program that helps you create a forecast, like Quantimed, could be used as a data source here)

When you use any of PipeLine’s consumption data entry tools (such as Clone, Interpolate, or Apply Trend), the data source will automatically be filled in for you, indicating which of the functions you used to enter the data. See the Usage Guidelines chapter of this guide, and the *PipeLine 5: An Addendum to the PipeLine 4 User’s Guide* for additional information on Clone, Interpolate, and Apply Trend.

- stock (e.g., warehouse reports that tell you about transfers, expiries, and physical counts could be a data source for stock entries)
- shipments (e.g., reports from your suppliers or a clearinghouse website, like the Reproductive Health Interchange, could be a source for this information).

Several typical data sources are included as defaults under each of these categories. You may delete them if you wish or add additional data sources that are relevant for your program, such as Bin Card, Quarterly Report, or Report and Requisition.

**Funding Sources**

Some programs want to record separate data on the organizations providing funding for specific shipments, which may be different from the organizations actually shipping the products. If this situation is not relevant to your program, you do not need to enter anything here; it is optional. As with other Background Data fields, a few funding sources are included by default in any new database. These defaults may be deleted or replaced, if you wish.

Funding sources are a new feature included in PipeLine 5.0 and later. For additional information on Funding sources, please see page 31 of *PipeLine 5: An Addendum to the PipeLine 4 User’s Guide*, where the concept is thoroughly described.

**Getting Help**

If you have a question that is not answered by the PipeLine documentation, or you experience a problem while using PipeLine, there is a dedicated email address to answer PipeLine users’ questions. In order to provide you with the most accurate assistance, we need details about the problem you are having. When you email us, please tell us—

- what operating system you are using
- what version of Windows you are using
- a detailed description of the problem:

  - If you are getting an error message, please include screenshots, and also the conditions that cause the error (e.g., the screen you are on, or the report you are attempting to view, etc.).
The PipeLine help email is Pipelinehelp@jsi.com. A form to submit with your help request is included in Appendix C of this guide.
Usage Guidelines

This section describes how to accomplish common supply chain management tasks with PipeLine, including forecasting, supply planning, and program monitoring. There are case studies from countries using PipeLine to do these tasks throughout the text. Each case study describes products and programs managed with PipeLine, how the databases are organized, and any other unique features about the country’s use of PipeLine.

Depending on the program you are working with, you can use the information in this section in different ways, as follows:

- If you have a new PipeLine data file, and your program has no historical data and no existing stocks, enter your forecast data first, then create your supply plan by scheduling shipments.

- If you have a new PipeLine data file, but your program has historical data and existing stocks that have not been entered, first enter historic stock data, consumption, and shipments. Then create your forecast and supply plan.

- If you have an existing PipeLine data file containing historical data, check to make sure your historical data are accurate before continuing with forecasting and supply planning.

- In any scenario, continue to update PipeLine on a schedule that is logical for your program and shipment frequency (see the “Program Monitoring” section for details).

Quantification in PipeLine

The process of quantification includes two steps: forecasting and supply planning. Both of these steps may be accomplished with PipeLine; however, PipeLine’s strength is in supply planning. Figure 5 shows how forecasting and supply planning fit into the overall quantification process.
If you do your forecasting outside of PipeLine, you may simply use manual data entry to record the numbers for use in supply planning. Depending on how many products are in your forecast, however, manual data entry can be very time-consuming. To shorten the data entry process, PipeLine has four automated options for entering forecast data: import from Quantimed, interpolation, apply trend analysis, and cloning. Two of these (interpolation and cloning) are well suited to particular forecasting situations. Interpolation, apply trend analysis, and cloning all have one characteristic in common: they should never be considered to encompass a thorough forecasting process. They are only a starting point for creating a forecast. Forecasts created using interpolation, apply trend analysis, and cloning do not take into account any new program plans, the effects of introducing new products (potential substitutes for existing products), or a variety of other situations that could affect a forecast. Interpolation and applying the trend analysis produce straight-line forecasts that do not show seasonal variation. It can be tempting to simply create a forecast using one of the automated methods in PipeLine and accept it at face value, without any alteration.
However, without taking into account assumptions about future program growth and any other factor that could affect future consumption, these forecasts are subject to a very high degree of error. Table 5 summarizes the strengths of each method of data entry and presents cautions about their use.

**Table 5. Deciding Which Forecasting Data Entry Method to Use**

<table>
<thead>
<tr>
<th>Data Entry Method</th>
<th>Strengths</th>
<th>Cautions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual</td>
<td>Gives the greatest amount of control in data entry&lt;br&gt;Applicable to any product, any situation</td>
<td>Can be time-consuming with many products&lt;br&gt;Can only enter forecasts for one product at a time</td>
</tr>
<tr>
<td>Quantimed import</td>
<td>Faster data entry than manual entry&lt;br&gt;Can enter multiple products at once</td>
<td>You must know how to use Quantimed and have prepared your forecast in it&lt;br&gt;You must have an XML file of products that includes the products in your Quantimed forecast (see pages 18 to 19 of this guide for a discussion of XML product files)</td>
</tr>
<tr>
<td>Interpolation</td>
<td>Faster data entry than manual entry&lt;br&gt;Does not require existing historical data to create a forecast (helpful for new products)</td>
<td>Forecast will require some adjustment for program plans, seasonality, etc., after being entered&lt;br&gt;Only forecasts in a straight line: not helpful for products expected to have non-linear consumption patterns&lt;br&gt;Can only enter forecasts for one product at a time</td>
</tr>
<tr>
<td>Apply trend analysis</td>
<td>Faster data entry than manual entry&lt;br&gt;Bases forecast on existing historical trend data</td>
<td>Forecast will require some adjustment for program plans, seasonality, etc., after being entered&lt;br&gt;Only forecasts in a straight line: not helpful for products expected to have non-linear consumption patterns&lt;br&gt;Less useful if previous trend is not expected to continue&lt;br&gt;Can only enter forecasts for one product at a time</td>
</tr>
<tr>
<td>Clone</td>
<td>Faster data entry than manual entry&lt;br&gt;Can enter multiple products at once&lt;br&gt;Data entered reflect whatever trends were shown in the product you initially forecast for (e.g., seasonal variation, etc.)</td>
<td>Must have a forecast for at least one product already done and entered into PipeLine before you can clone&lt;br&gt;Forecast might still require some adjustment after being entered, especially if the product you are cloning is used in multiple ways (e.g., disposable gloves used for multiple medical procedures other than the one you forecast for)</td>
</tr>
</tbody>
</table>
No matter which method of data entry you choose, you enter forecast data in the Consumption data screen. Note that although PipeLine is considered a logistics tool because of its focus on supply planning, you can enter forecast consumption data from non-logistics sources. For example, if your forecast is based on demographic, morbidity, or services data, these can be entered as consumption data forecast in the same way that actual dispensed-to-user or issues data could be entered.

For a thorough exploration of quantification, forecasting methodologies, and supply planning for a wide variety of products, see the forecasting guides given in the References section of this document. The following case study from Burkina Faso shows how that country completes its quantification process using PipeLine.

### PipeLine Case Study: Burkina Faso

In Burkina Faso, the PipeLine database for contraceptives is managed by the Family Health Directorate (FHD). The Regional Logistics Advisor trained FHD, PROMACO (the social marketing program), and Association Burkinabé pour le Bien-Etre Familial (ABBEF) (an International Planned Parenthood Federation affiliate) on PipeLine 3.0. These organizations participated during the 1998 to 2002 contraceptive procurement table (CPT) exercises, taking the opportunity to continue to learn and use PipeLine. The in-charge of logistics at FHD has continuously managed the PipeLine database, organizing and participating in the annual quantification exercises, even during the period when the project no longer provided assistance to the country starting in 2008. The in-charges’ dedication and commitment ensured the database was up-to-date, contributing to the ability of the FHD to budget for the required contraceptive needs on an annual basis.

To build capacity and sustainability with the FHD, the in-charge trained the Head of the Reproductive Health Unit on PipeLine. Together, they facilitated the quantification. The Head has now taken over responsibility of preparing and running the quantification using PipeLine data.

Most recently, the project created a database for malaria commodities with the National Malaria Control Program, which is managed by the project at the moment. Only central-level data is available for malaria commodities, but it is planned for districts to begin sending in quarterly reports so the National Malaria Control Program will be able to use consumption data for forecasting. A PROMACO staff person has since trained a fellow staff member who is currently using PipeLine and also participates in FHD-organized quantifications.

### Database Management

The database is updated when new shipments arrive. Data for pipeline originates from a variety of sources. Stock on hand data comes from the central warehouse, district stores, and from ABBEF. Consumption data comes from the health facilities. Data are backed up onto a flash drive or saved onto another computer.

### PipeLine Reports Used for Advocacy

Procurement planning take places twice a year at the beginning of the year and then six months later. All of the regional pharmacists participate in the quantification, where they present consumption, stock on hand, and losses and adjustments for their region. The group discusses the quality of the data before it is entered into PipeLine. PipeLine reports are used to present the results of the forecast and quantification as advocacy to the partners (the partners include Centrale d’Achat des Médicaments Essentiels Génériques, the pharmacy department, PROMACO, ABBEF, JHPIEGO, the Marie Stopes International, the United Nations Children’s Fund, the United Nations Population Fund, USAID, the World Health Organization, and others) to mobilize resources to fill any funding gaps identified. For example, a presentation of artemisinin-based combination therapy stock status using reports generated from PipeLine prompted the Programme d’Appui pour le Développement Sanitaire (Programme to Support Healthy Development) to use basket funds from the health sector to reduce the financing gap for artemisinin-based combination therapies. In another example, after the presentation of the contraceptive quantification results showed an imminent stockout of pills, the Ministry of Health used cost recovery funds to place an emergency order.
Option 1: Manual Data Entry

This option is the least automated (and therefore the most time-consuming) and is appropriate for any kind of product. For step-by-step instructions about entering data manually, see page 5-1 in *The PipeLine 4.0 User’s Guide*. To speed manual data entry, enter forecast data in quarterly, biannual, or annual quantities. For example, if you have a two-year forecast, you could make two data entries, one for each year, encompassing 12 months of forecast consumption. When you later view your data in reports such as the Stock Status Report, the 12-month quantities you entered in the consumption data screen will be divided by 12 to give a monthly forecast consumption figure. If you expect consumption to be evenly distributed over a one-year period, entering a 12-month forecast figure is appropriate. However, if you expect that consumption will vary from month to month or quarter to quarter, it would be better to enter your forecast consumption data monthly or quarterly to show this variance. Entering data in smaller units of time is more labor-intensive, but it ultimately produces a more nuanced picture of the forecast in graphs and reports. The smallest unit of time that may be entered is one month. Data entered quarterly or in periods of six months will be divided evenly by three or six, respectively, in Stock Status graphs and Reports. In figure 6, data are entered for a 12-month time period, starting in month 1 (January). To enter data in a six-month period, you could start in month 1, for the next 6 months, or in month 6 (June) for the next six months.

Figure 6. Consumption Data Entered for a 12-month Time Period

Option 2: Forecast Import from Quantimed

Quantimed software, produced by Management Sciences for Health, is used to forecast total units and total costs of medicines and medical supplies needed in health programs. It offers three methodologies for forecasting: past consumption, morbidity, and proxy consumption.¹ Quantimed

¹ For more information about Quantimed, please see [http://www.msh.org/projects/sps/Resources/Software-Tools/Quantimed.cfm](http://www.msh.org/projects/sps/Resources/Software-Tools/Quantimed.cfm)
and PipeLine are linked through an export/import process: forecasts created in Quantimed may be imported into PipeLine for supply planning. After completing your forecast in Quantimed, you must first export the forecast as an XML file before you can import it into PipeLine. This guide does not describe forecasting in Quantimed; it assumes that you are already familiar with Quantimed and have created your forecast in it.

**Exporting Forecast Data from Quantimed**

To begin the export, go to Analysis and Reports > Scaling-up Morbidity-Based Estimate: Medicines. Before exporting, check to see if your version of Quantimed has two buttons on the right-hand side above the text “Export Monthly Totals to Excel File,” as shown in figure 7. If you do not see these buttons, contact Management Sciences for Health to get an updated version of Quantimed.

**Figure 7. Exporting Monthly Forecast Totals**

Make sure that the quantities displayed in the Analysis and Reports > Scaling-up Morbidity-Based Estimate: Medicines screen meet your required parameters and include all the Conditions/Care Provided you desire in the calculation.

Click on the button marked “xml,” and the screen “Export to xml file” appears, as shown in figure 8.
Note: the field “Recipient” should display with the name of the active dataset.
Click the button “Select XML file for Export,” and the XML Output File box appears, as shown in figure 9.
Figure 9. Selecting the Output Destination

Select the folder to save the XML file in (could be the relevant folder under PipeLine) in the “Save in:” field; type a filename in the “File name:” field; click “Save.” The default filename is the name of the dataset. Remember where you saved it so that it can be found easily when you are ready to import into PipeLine.

The full path and name for the XML file will appear in the previous screen (see figure 10), and the button “Create XML” is now active. Click on this button. After export is successful, the confirmation screen will appear.
Click “OK”; you will then be returned to the Analysis and Reports > Scaling-up Morbidity-Based Estimate: Medicines screen, and the XML file should be saved in the chosen location.

**Importing Quantimed Data into PipeLine**

To import Consumption data from Quantimed into PipeLine, you will need to first have two types of files for import:

1. The forecast consumption data, generated from Quantimed
2. A list of products such as the sample XML files included with PipeLine.

Both these files must have the file extension “.xml.”

In PipeLine, from the “Import” drop-down menu (see figure 11), select Consumption > Forecast.

Select the locations of your Consumption Data and Product List XML files in the “Import Forecast Data” dialogue box shown in figure 12.
When you select “OK,” the Forecast Import Reconciliation Screen appears (see figure 13). If a product included in your forecast is already in PipeLine, it will appear in the “PipeLine Product” column on the right. This means that the forecast data you are importing will automatically overwrite any existing forecast data for that product (data marked as “actual” will not be overwritten).
In the Forecast Data Import Reconciliation Screen, “deselect” any products whose forecast data you do not wish to import by clicking on the check mark in the select column. The check mark will be removed when you click on it, and the forecast data from Quantimed will not be imported into PipeLine. If you are importing products from the SCMS product list, cross check to match the “Product” code (e.g., 102190 for abacavir 20 mg/mL in figure 14) you are importing with the “SCMS product” code to ensure that the forecast is being imported into the right product. If the codes do not match between the “Product” and “SCMS Product,” match them manually by selecting the appropriate product from the “SCMS Product” list column to match. If you are using a custom product list (e.g., not the SCMS product list or one of the default XML files that comes with PipeLine), your products may be imported in BUs, and will need to be manually converted to packs after import. This depends on the data in the XML product list you are using (see pages 18 to 19 of this guide for a discussion of the XML product lists.)

**Figure 14. Selecting and Deselecting Data for Import**

<table>
<thead>
<tr>
<th>Product</th>
<th>Select</th>
<th>SCMS Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>102190--Abacavir 20MG/ml</td>
<td>✔</td>
<td>102190--Abacavir 20mg/ml 243 ml</td>
</tr>
<tr>
<td>102159--Abacavir 300MG/Tab</td>
<td>✔</td>
<td>102159--Abacavir 300mg 60 Tabs</td>
</tr>
<tr>
<td>102161--Didanosine 100MG/Tab</td>
<td>✔</td>
<td>102161--Didanosine 100mg 60 Tabs</td>
</tr>
</tbody>
</table>

Be sure the “Override Default Case Size on Import?” box is selected if you want to override the default case sizes already in your PipeLine database with the case sizes in the import file (see figure 15).

**Figure 15. Overriding the Default Case Size**

When you have successfully imported data, a report will be displayed confirming the data has been imported. This report is not saved anywhere—you should print it if you would like a copy for your records.

**Option 3: Interpolation**

Interpolation can be applied to forecast for any product in a straight line. No historical consumption data are required to enter forecast data using interpolation. It can therefore be very useful for entering data for a new product, or one for which there is no historical use data available. You can also interpolate future consumption for a product with existing historical consumption data (actual or forecast)—if you choose to do this, your interpolation will start with the last existing average monthly consumption (AMC) marked as “actual” in the database. Note that you cannot create historical (e.g., “actual” consumption) data via interpolation. Interpolation will always begin entering data in the consumption screen in the current month and year. Data will be entered as “forecast” (not actual) on a monthly basis.
For step-by-step instructions on using the interpolation feature to enter data, see page 12 of *PipeLine 5: An Addendum to the PipeLine 4 User’s Guide*.

**Option 4: Apply Trend Analysis**

Like interpolation, apply trend analysis also creates a straight-line forecast. Unlike interpolation, however, this data entry method is based on historical trend data as shown in the Trend Analysis graph. Using either semi-averages or linear regression, PipeLine calculates a linear trend line using existing actual consumption data. The apply trend analysis feature inputs the linear trend data directly into the Consumption screen as forecast consumption. In order to produce a trend line in the graph, you need to have at least six months of historical, *actual* consumption data. You cannot produce a trend line from consumption data marked as forecast in the Consumption data screen.

While you need only six months’ data to produce a trend line, it is ideal to have at least two years of actual (as opposed to forecast) historical consumption data in your data file before attempting to use the trend line to forecast.

For step-by-step instructions on using the apply trend analysis feature to enter data, see *New Features and Existing Issues in PipeLine 5.1*.

**Option 5: Cloning**

Cloning is a quick way to enter data for products used in conjunction with one another in fixed ratios. In order to clone consumption, you must have done a forecast for one of the products, which you can then clone onto other products and adjust by a factor you determine.

For example, if you have done a forecast for a laboratory product that is used in a ratio of 1:2 with another product, after you have input the first product’s forecast, you can clone it onto the second product by a factor of two. You can apply the clone procedure to as many products as you wish—you may clone one product’s data onto many products at once.

Forecast data entered by the clone procedure will be entered monthly and may only be entered for future months (like interpolation, you may not enter historical data using the clone feature). Even if the historical data you are cloning are entered in another time frame (e.g., quarterly), the cloned data will still be entered monthly.

For step-by-step instructions on using the clone feature to enter data, see page 10 of *New Features and Existing Issues in PipeLine 5.1*.

**Using PipeLine’s “Copy” Function to Make a Backup Database**

When forecasting or performing other updates in PipeLine, you may wish to back up your files or occasionally share a copy of your data file with colleagues. PipeLine has a “Copy” function under the file drop-down menu that makes this easy. However, this function does not work like the typical Microsoft Windows “save as” option.

When you select File > Copy in PipeLine, you create a new file that is an exact copy of the current file that is open. (Be sure to give your copy a different file name than the original in the Copy Files to dialogue box.) PipeLine automatically adds “bk” to the file name (for backup), but you can change this if you prefer a different naming convention for copies (see figure 16).
If you now open the Window drop-down menu, you will see that only one file is open. The open file is your original file. Your copy has been created, however, and if you try to open it, you will receive the message found in figure 17.

You see this message because PipeLine treats the original and the copy as one file. If you change the program name or program code, then PipeLine will treat them as two separate files. It is important that the files be separate if you expect to send the copy to someone else who will then make changes
to it. In that case, you must change both the program name and program code, or you will receive an error and be unable to open the files (see figure 18).

**Figure 18. Location of Program Name and Program Code Fields**

Supply Planning

After creating the forecast, the next step in quantification is supply planning. This step is often overlooked, to the detriment of program budgets, staff, and supply chain capacity. Forecasting without supply planning frequently results in stock imbalances, wasted funds, over- or under-ordering, and a host of other undesirable outcomes. Supply planning is one of PipeLine’s strengths, and the software is designed to make the supply planning step in quantification easy and quick. Like forecasting, however, supply planning in PipeLine still requires input from stakeholders in the forecasting process, such as program managers, suppliers of products, and logisticians.

What is a supply plan? It is a schedule of future shipments of any product that explicitly accounts for future consumption, amounts of product that are already in stock, and any quantities that have already been ordered, as well as expected loss/wastage or other adjustments. PipeLine automates the supply planning process, making it easy to see how incoming shipments affect stock levels and schedule shipments appropriately. You can also create a supply plan manually in PipeLine—although this is more time-consuming, it provides maximum control over shipment scheduling.

Entering a Beginning Balance

Stock on hand data refer to any existing stocks of products already in your supply chain, for which you are creating a supply plan. If a product is new, and there are no existing stocks, you can skip this step. Your first shipment will provide the supply for future consumption. If you have existing stocks, enter them before beginning your supply plan. You enter stock on hand as a positive stock adjustment in the Stock screen. (See page 5-11 of the PipeLine 4.0 Users’ Guide for a step-by-step description of entering stock data in the Stock screen.) Your first stock entry should be dated at the end of a month before your first forecast consumption entry. For example, if your forecast begins in April, then your existing stock should be entered as a positive stock adjustment on 31-January of the same year. It could also be entered on 31-March (regardless of the month, it must occur on the last day of the month in PipeLine, because it will be automatically added as the next month’s beginning balance).
When managing data in PipeLine, it is important to remember that you are managing stock for an entire program. When you enter stock on hand data, you ideally have stock counts from every level of your supply chain on the same date. If it is not possible to get stock on hand data from all levels, or if the data do not come from the same date, you will have to make some adjustments to help PipeLine more accurately reflect your current stock situation. Table 6 presents a summary of adjustments you may choose to make to your opening balance data.

### Table 6. Suggested Adjustments for Stock Data Problems

<table>
<thead>
<tr>
<th>Stock Data Problem</th>
<th>Suggested Adjustments</th>
</tr>
</thead>
<tbody>
<tr>
<td>You only have stock on hand data from one level of a multilevel supply chain</td>
<td>Estimate the amount of stock that exists at lower levels of the supply chain, and add it to the stock on hand data that you have</td>
</tr>
<tr>
<td>You have stock counts from multiple levels of the supply chain, but they are from different dates</td>
<td>Decide which level's stock count you will use, and adjust the other stock counts accordingly for consumption and quantities received during the time period between counts at various levels; ideally, choose the stock count that is closest to but precedes your first month of forecasted consumption</td>
</tr>
<tr>
<td>You have stock on hand data from December 31, but your forecast begins in March</td>
<td>Adjust the stock on hand data for three months of consumption (if any), losses, and any shipments you will receive between December 31 and the beginning of the forecast; you may need to estimate consumption for this period if you have not received information about it yet</td>
</tr>
</tbody>
</table>

Any of the adjustments suggested in Table 6 are useful to ensure your data reflect the same time period and the entirety of your supply chain. However, an important caveat is that all of these adjustments introduce the possibility for error into your supply plan. If you make any adjustment based on missing data or data from different time periods, seek a full-system stock count (conducted on the same day at all sites) as soon as possible. When you have the stock on hand in the entire system from the same day, be sure to enter it into PipeLine as an adjustment, to correct for the artificialities introduced by estimating stock on hand quantities.

### Entering Pending Shipments

Before beginning your supply plan, ensure that any previously ordered shipments that have not yet arrived have been entered into PipeLine in the Shipments screen. As these shipments will affect your stock levels, it is important that they be entered before you begin planning new shipments.

### Entering Historical Data

PipeLine can help you manage stocks and shipments in the future, but it can also help you understand past trends in consumption, ordering, and supply planning. If you have historical logistics data, however, you can enter the following into PipeLine to get a better picture of your program’s past history:

- historical consumption data (either actual consumption or a proxy, such as issues)
- historical stock losses and adjustments
• past shipment information, including arrival dates.

You do not need to enter any historical logistics data, other than a beginning stock balance (if it exists) in order to create your supply plan in PipeLine.

**Planning Shipments Using PipeLine**

While a forecast can be created for more than two years for advocacy purposes, we suggest creating a supply plan for no longer than two years, especially if funds are allocated to your project or program annually. In some cases, you may not be able to get suppliers to agree to provide shipments more than one year in advance. A supply plan is a living document, meant to be updated regularly (we suggest every six months, at a minimum). In nearly every case, it is not possible to forecast what stocks and consumption will be with any accuracy more than two years in advance, making it difficult (and fruitless) to plan shipment quantities. We therefore recommend against planning shipments for longer than two years in advance, even if your forecast extends beyond two years. The case study from Paraguay that follows shows how the Ministry of Health uses various reports in PipeLine for decisionmaking in planning shipments and future financing.
PipeLine Case Study: Paraguay

Paraguay is an example of a country successfully taking over the monitoring, management, and procurement planning of health products using PipeLine. In Paraguay, PipeLine is used by the Ministry of Health (MOH)’s Health Program General Directorate (Spanish acronym is DGPS) with limited support from the USAID | DELIVER PROJECT. The MOH has been maintaining PipeLine on their own for the past three years to manage family planning products. These include male condoms, Depo-Provera, oral contraceptives, intrauterine devices, and emergency oral contraceptives.

Using PipeLine Data for Decisionmaking

Paraguay primarily uses PipeLine to ensure regular and consistent stock levels throughout the system. Consumption data is collected by the regions and sent to the central level on a quarterly basis. Data is manually entered into the country’s logistics management information system by DGPS. The logistics management information system is currently paper-based at the service delivery point level, consolidated at the regional level, and entered to PipeLine at the central level. Once data is entered into the logistics management information system, the MOH reviews the data for inconsistencies and data quality with guidance from the project. Feedback is provided by the central level to verify and correct data with the regional level. As soon as information is validated, corrections on quantities and other adjustments are made in PipeLine. Previously, the project met with the MOH every quarter to review the PipeLine database. Now meetings are twice a year, mainly to review the MOH’s forecast and shipment plans. The project maintains a copy of the database as a backup.

The MOH uses the features in the Consumption screen under the Commodities Data section and the Stock Status Report under the Reports section to develop the forecast and procurement plans. The MOH uses these reports as well as the Stock Status and Consumption graphs to look at past trends and to calculate the percentage increases from year to year to make forecast decisions. The project looks over the MOH’s future consumption trends and future planned shipments and provides suggestions on reducing or increasing the shipment quantities. The Funding of the Reproductive Health Commodities and Safe Birth Kits law guarantees funding to cover all MOH reproductive health supplies and family planning supplies based on projected needs. The MOH uses the Annual Shipment Cost Report and views shipments marked as “Planned” to determine the costs of the forecasted contraceptives. Once the forecast and procurement plan is finalized, it is submitted by the Logistics Director to the United Nations Population Fund, who acts as the procurement agent for contraceptives (all of the required contraceptives for the public sector are funded by the Government of Paraguay).

Success and Challenges in Building Sustainability

When the project began working in Paraguay five years ago, capacity building in supply chain management started right away. During the first two years, the DGPS received training on PipeLine and logistics management from the project. The project worked closely with the MOH to jointly prepare forecasts using PipeLine data, holding workshops attended by officers of the DGPS for two years. Over time, fewer MOH staff attended. The Logistics Director of the DGPS is now the only person empowered and qualified enough to manage the PipeLine database. It is hoped additional staff can be trained on PipeLine in the future. The ability of the DGPS to eventually take over PipeLine, forecasting, and procurement planning can be attributed to the Logistics Director’s understanding of what is needed for a strong logistics system: that PipeLine is a powerful tool to monitor the entire contraceptive supply chain, it can produce reports that will help advocate for adequate funding, and that it can assist with making redistributions when shipments are delayed. Because of the commitment by the Logistics Director to lobby for enough funding, closely monitor stock levels and consumption, and carefully plan distribution of contraceptives, the stockout rate was only 1% for all methods in 2010.
When planning shipments in PipeLine, you have two options: you can use PipeLine’s automatic shipment planning feature, or you can do your shipment planning manually. The difference between these two is that in automatic planning, PipeLine calculates the shipment quantity for you (although you can change it if you wish). Each has its advantage or disadvantage depending on your situation. Table 7 presents various situations that might make one option preferable over the other.

### Table 7. Shipment Planning Considerations

<table>
<thead>
<tr>
<th>Use automatic planning if…</th>
<th>Use manual planning if…</th>
</tr>
</thead>
<tbody>
<tr>
<td>You manage stocks using a maximum/minimum system</td>
<td>You have no maximum/minimum, or your system does not abide by its established maximum/minimum for ordering and stock management</td>
</tr>
<tr>
<td>You can be reasonably sure that your suppliers can bring in shipments where and when you need them, provided you have given proper allowance for their lead times</td>
<td>Your suppliers have difficulty scheduling shipments to meet your needs, or have other constraints (such as only being able to deliver one shipment a year)</td>
</tr>
<tr>
<td>You are reasonably certain of your suppliers’ lead times, and they do not change frequently</td>
<td>Your suppliers have uncertain or variable lead times</td>
</tr>
</tbody>
</table>

It is likely, of course, that your system is a mixture of these considerations, some of which suggest manual planning, and some of which imply that automatic planning is appropriate. In that case, the strongest indicator of which method of shipment planning you should use is whether or not you have established a maximum/minimum inventory control system. PipeLine uses desired stock level to calculate shipment quantities during automatic shipment planning; without a desired stock level, it cannot calculate a shipment quantity for you.

### Option 1: Automatic Shipment Planning

Automatic shipment planning is done in the Stock Status Report screen, and it should not be done until you have entered—

- products, including their maximum/minimum and desired stock levels
- forecast data
- a beginning stock balance (if any) and pending shipments (if any).

For a detailed description of the Stock Status Report, see page 7-2 of *The PipeLine 4.0 User’s Guide*. Once you have set the time frame for the report and selected the product for which you would like to plan shipments, click on the “Show Data” button to display the report on the screen (see figure 19).
You can plan shipments in any month you desire; however, we recommend planning shipments to arrive during the months where your stock falls below minimum. (You can see this occur by looking at the “Stock in Months” column, next to Losses/Adjustments in the report.) To automatically plan shipments—

1. locate the row corresponding to the month in which stocks fall below minimum
2. align the cursor in the shipments column
3. double-click; you will receive the message found in figure 20

4. if you select “Yes,” you will be taken automatically to the Shipments screen in PipeLine. (You may receive a message first asking you if you would like to round your shipment quantity up to the default supplier’s case size, if the calculated quantity does not correspond to the case size of the default supplier.) A new shipment will have been entered for you. Several pieces of information will also be automatically input, but all can be changed if you wish. That information includes the following:
   a. Supplier: your default supplier for the selected product is automatically input
b. **Quantity**: the quantity shown is the amount needed to bring stocks back up to your *desired* stock level (not your maximum)

c. **Shipment ID**: PipeLine starts your first planned shipment with identification number 1 and automatically numbers each shipment afterward, going up

d. **Status**: the status will automatically be set to “Planned”

e. **Receive date**: the receive date will be the last day of the month in which you planned the shipment.

5. The Data Source and Funding Source fields will show the value “Not Selected.” Change these fields to reflect the appropriate values if you wish.

6. Click “Save” when you have completed any desired modifications to the planned shipment. When the shipment is saved, it will appear with the other shipments above the data entry section of the Shipments Screen.

7. Below the “Save” button you will see a button called “Back,” which is only visible when you enter the shipment screen from the Stock Status Report. Click on “Back” to return to the Stock Status Report, maintaining your original time frame and product (shown in figure 21).

**Figure 21. Location of the Back Button in the Shipments Screen**

---

**Option 2: Manual Shipment Planning**

Manual shipment planning can be done either in the shipments screen or in the Stock Status Report screen. If you have a maximum/minimum and desired stock levels, you can use the same procedure as automatic shipment planning, as previously discussed. Simply place your cursor in the row of the month where you want your shipment to arrive and double-click. You will be taken to the Shipments screen, where you can adjust the quantity of your shipment as you wish.

If you do not have a maximum/minimum, start planning in the Shipments screen by creating a new shipment with your desired receipt date and quantity. Then check the Stock Status Report to see how your shipment affects the MOS. (MOS is still calculated, even if you do not have a maximum/minimum, because it relies on AMC and ending balance to produce a figure.)
How PipeLine Calculates Months of Stock

If you are using a maximum/minimum inventory control system, we recommend that you plan a shipment to arrive whenever your stocks fall below the minimum stock level. You can determine when this will occur by looking at the Stock in Months column of the Stock Status Report in PipeLine. It is useful to understand the calculation underlying stock in months, which involves both the ending stock balance from the previous month and the AMC.

PipeLine uses a three-month rolling average to calculate AMC; however, this AMC is not based on historical consumption data, rather on future consumption. PipeLine’s AMC calculation is:

\[
\text{AMC} = \frac{(\text{Current month} + \text{Future month 1} + \text{Future month 2})}{3}
\]

Although in forecasting you would consider trends based on previous months’ consumption, for planning shipments in the future, it is the forecasted future consumption (along with the stock on hand and on order) that determines the amount needed in each shipment.

Stock in months is calculated by:

\[
\text{Ending balance of current month} / \text{AMC}
\]

Table 8 provides an example of the AMC and MOS calculation in PipeLine (with consumption in June and July, which are not shown, at 10,666 and 5,000, respectively). The Stock in Months figure represents the amount of stock available at the end of the month, after all consumption, receipts, and adjustments have been accounted for.

### Table 8. Example of PipeLine AMC and MOS Calculation

<table>
<thead>
<tr>
<th>Month</th>
<th>Consumption</th>
<th>AMC Calculation</th>
<th>AMC</th>
<th>Ending Balance</th>
<th>Stock in Months</th>
</tr>
</thead>
<tbody>
<tr>
<td>February</td>
<td>9,533</td>
<td>(\frac{(9,533 + 9,534 + 10,667)}{3})</td>
<td>9,911.3</td>
<td>110,934</td>
<td>11.2</td>
</tr>
<tr>
<td>March</td>
<td>9,534</td>
<td>(\frac{(9,534 + 10,667 + 10,667)}{3})</td>
<td>10,289.3</td>
<td>101,400</td>
<td>9.9</td>
</tr>
<tr>
<td>April</td>
<td>10,667</td>
<td>(\frac{(10,667 + 10,667 + 10,666)}{3})</td>
<td>10,666.7</td>
<td>90,733</td>
<td>8.5</td>
</tr>
<tr>
<td>May</td>
<td>10,667</td>
<td>(\frac{(10,667 + 10,666 + 5,000)}{3})</td>
<td>8,777.7</td>
<td>80,066</td>
<td>9.1</td>
</tr>
</tbody>
</table>

Adjusting the Average Monthly Consumption Calculation

Now that you understand how PipeLine calculates stock in months and AMC, you can manipulate this calculation to adjust for programmatic realities, such as seasonal fluctuations in consumption.

For a variety of reasons, the three-month average used by PipeLine might be too small to accurately reflect average consumption. If your consumption data are highly variable over time, then a longer average may smooth this variability and enable better planning. You can reset the AMC to a time period of up to 12 months using PipeLine’s “Recalculate AMC” feature (see table 9). (Step-by-step instructions for using Recalculate AMC can be found starting on page 15 of *PipeLine 5: An Addendum to the PipeLine 4 User’s Guide*. )
Table 9. Deciding to Recalculate your AMC

<table>
<thead>
<tr>
<th>Situation</th>
<th>Suggested Recalculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have strong, predictable seasonal variation in your consumption data</td>
<td>Use a number of months that is equal to the length of seasonal variation plus 2. For example, if your seasonal fluctuation is five months long, use an AMC of seven months.</td>
</tr>
<tr>
<td>Your consumption data are highly variable across time and do not show any predictable pattern</td>
<td>Use a larger number of months in the average, even up to one year, to smooth out the average for shipment planning purposes. (This method could be especially helpful if you use issues data as a proxy for consumption.)</td>
</tr>
</tbody>
</table>

**Program Monitoring**

After the forecast and supply plan are created, PipeLine becomes a valuable tool for adjusting both as time goes on and conditions change. We recommend keeping your PipeLine database up-to-date with the latest consumption, shipment, and stock information. How often you do this depends on your program, how often you receive reports, and any adjustments that must be done to the data before you enter them into PipeLine.

In program monitoring, your goal should be to accurately reflect the flow of stocks through your supply chain. This includes making adjustments for losses and transfers into and out of the system.

**Updating Consumption Data**

If you have historical consumption data, it is useful to enter as much of it as you have. Prior to forecasting, entering at least two years of consumption data (if you have it) will enable you to make best use of the PipeLine Trend Analysis graph to see linear trends in your data. Historical consumption data must be entered manually; there is no automated way to enter it. Like forecast consumption, you can enter it in larger time periods (e.g., quarterly or annually) to speed the data entry process. Whether you enter the data monthly, quarterly, annually, or in some other time frame depends on the level of detail you need to see about historical consumption. Entering data on a monthly basis will give you the finest level of detail, but will take the most time. If your data do not show any variation from month to month (or if you only have quarterly or annual totals for previous years’ consumption), then it is better to enter these data in the time frames that they came in, rather than entering them monthly. PipeLine will automatically divide the totals you enter out by month in reports that use monthly data, such as the Stock Status Report.

Many programs enter new actual consumption data monthly, quarterly, or at least every six months. The more frequently you update your actual consumption data, the more accurately you can see how

---

**Using Issues as a Proxy for Consumption**

If your logistics management information system does not capture dispensed-to-user data, or if the data are not complete, you may wish to use historical issues data from a particular level of the supply chain as a proxy. We recommend using issues from the lowest level of the supply chain where data are reasonably complete and reliable, to get as close to the product’s end user as possible. Do not add issues from multiple supply chain levels together, as this results in double-counting of products issued. When you enter historical issues data as a proxy for consumption, you are explicitly assuming that everything issued from that level of the supply chain has been consumed.
incoming shipments will affect your stock status in the future. You can then make adjustments to shipment totals and timing to keep your stocks within balance, avoid stockouts, and reduce or eliminate overstocks.

**Preserving Forecast Data**

Many programs want to analyze the accuracy of their forecasts against their actual consumption data. Unfortunately, there is no formal way to do this using PipeLine's graphs or reports; however, you can keep your forecast and actual data in PipeLine for the same time period. (You can then extract it into Microsoft Excel to perform a forecast accuracy analysis. See *Getting Data Out of PipeLine* on page 48.) You may have two records for any given time period as long as one of these records is flagged as actual and one as forecast. For example, in Figure 22, there are two records for January 2010 to March 2010. The first record shown is the forecast, and the second is the actual consumption. Note that if an actual consumption record exists for any time period, it will always be shown in graphs and reports, even if forecast consumption exists. The only way to compare forecasts and actuals in PipeLine is to view them in the Consumption screen. To perform any additional analysis or to graph them, you will need to export the data into Microsoft Excel.

**Figure 22. Forecast and Actual Consumption Data for the Same Time Period**

![Forecast and Actual Consumption Data](image)

**Updating Shipments Data**

If you have or can reconstruct historical shipment data, enter it into PipeLine along with your other historical data items. The more information you can enter (such as unit prices, freight costs, arrival dates, etc.), the more PipeLine can provide useful summary reports.

Shipment updates and entry of new futures shipments are the data items that many programs must update frequently. Some programs using PipeLine update shipments every week. Although you may not need to update your shipment data that often, monthly or quarterly updates are suggested as a best practice. If you have multiple PipeLine databases for the same program (as with antiretroviral databases shown in the following Zambia case study), you can use PipeLine's Shipment Import feature to import a shipment update from one database to another. Step-by-step instructions for
using this feature can be found starting on page 26 of *PipeLine 5: An Addendum to the PipeLine 4 User’s Guide*.

Any additional information that you can provide about shipments, such as actual product and freight costs, and actual lead time information (for example, the date on which an order was placed), will enhance the utility of PipeLine’s shipment reports. The following case study from Zimbabwe shows how frequent updates of shipment information and forecasts contribute to coordination of all partners activities in the supply chain.

**PipeLine Case Study: Zimbabwe**

The Zimbabwe office manages a wide range of commodities ranging from condoms and contraceptives, medications for malaria, tuberculosis, and opportunistic infections; HIV test kits; prevention of mother-to-child transmission; and adult and pediatric antiretrovirals. Each of the product types has a separate database overseen by a designated user. The Delivery Team Topping Up logistics management information system is the source of data for all of the product types, except for antiretrovirals and medication for opportunistic infections, which are provided by the Zimbabwe Information System for HIV/AIDS Commodities (ZISHAC) software. The ZISHAC software is managed by the Ministry of Health and Child Welfare Department of Pharmaceutical Services Logistics Supply Unit (MOHCW DPS LSU). In the Delivery Team Topping Up system, the team leader collects logistics data during the delivery of commodities to health facilities and enters it directly into the Delivery Team Topping Up software. Once the team leader completes the deliveries, the data are uploaded at the main office in Harare. In the antiretroviral logistics system, the logistics data are sent to the central level by the service delivery points, where it is captured in the ZISHAC software.

**Data Use and Verification Take Place in Partnership**

Data for PipeLine is received and updated on varying schedules. For condoms and contraceptives, malaria and tuberculosis medications, HIV test kits, and prevention of mother-to-child transmission antiretrovirals, logistics data (consumption, stock on hand, and adjustments) is received quarterly, while opportunistic infection and pediatric antiretroviral data is received on a bimonthly basis. However, all of the databases are updated every quarter. A backup copy of each of the databases is made each day, and a copy of each database is kept at the central level. Updates are centralized (i.e., only the central level database is updated and all other users, such as logistics advisors, MOHCW DPS LSU Logistics Officers, and the ZNFPC logistics manager, can request a copy to work from).

Data quality workshops are held between central level staff and health facility staff to review the logistics data that has been submitted and to resolve any discrepancies that may occur between patient and consumption data. These workshops which last about two and a half days are normally held once every month.

Population Services International, a social marketing organization, also uses Pipeline software to capture logistics data on male and female condoms in Zimbabwe.

**Multiple Uses of PipeLine Reports**

For antiretrovirals, test kits, and tuberculosis, malaria, and opportunistic infection medications, the MOHCW DPS LSU uses Pipeline to track incoming shipments by supplier notifying partners when shipments are expected to arrive, track stock status to avoid stockouts and expiries, and for advocacy efforts during forecasting and quantification periods. The Stock Status Report from PipeLine has also been used to exchange overstocked commodities with partners to avoid expiries. For condoms and contraceptives, a CPT working group chaired by the Zimbabwe National Family Planning Council and technically supported by John Snow, Inc., also uses Pipeline in the same way as previously mentioned. The Shipment Summary reports are used to highlight unfunded shipments during the Reproductive Health Commodity Security and the Procurement Logistics Subcommittee meetings.
**Adjustments and Stock Counts**

Adjustments to your data can be both negative and positive numbers. Examples of positive adjustments include—

- inbound transfers of stock from another program
- adjustments from stock counts that found additional stocks on the shelves (when compared to the recorded stock card balance).

Examples of negative adjustments include—

- losses of product, such as damage, expiry, or theft
- loans or transfers of products to another program
- adjustments from stock counts that found less stock on the shelf than expected (when compared to the recorded stock card balance).

In the Stock Status Report, PipeLine automatically calculates your stock on hand for you, based on this formula:

\[
\text{Beginning balance} + \text{Shipments} - \text{Consumption} +/\text{- Adjustments} = \text{Ending balance}
\]

When your adjustment is the result of a stock count, you can choose to either enter the adjustment to the stock balance manually or to have PipeLine calculate the adjustment for you. For the first option, you must know the difference between your expected ending balance in PipeLine and the actual ending balance of your stock count. For the second option, you need only know the number of your stock count, PipeLine will calculate a positive or negative adjustment for you, to bring the number shown in the Stock Status Report in line with your actual stocks.

**Using Tickler Reports**

There are two reports in PipeLine called “tickler” reports: PipeLine Action and PipeLine Problem. They are called ticklers because they are meant to remind you to take action either in regards to keeping your stock levels in balance or updating the information in your PipeLine database. These reports are described in detail in *The PipeLine 4.0 User’s Guide*, pages 7-10 to 7-13. We suggest reviewing the tickler reports at least quarterly.

- **PipeLine Action** analyzes the status of your shipments (planned, ordered, shipped, arrived, and received). Based on the lead times you input for the Suppliers and the receipt date of each shipment, it calculates the dates when you should order your shipment, when the shipment should ship, and when the shipment will be received. It is meant to prompt you to monitor and update your shipments’ statuses on a regular basis.

- **For all products, PipeLine Problem** summarizes when stocks will fall below your minimum, stockout, or are above maximum, and prompts you to take action (such as revising your shipments’ arrival dates or quantities). This report is most useful if you have established maximum and minimum stock levels.

You can also run tickler reports on for past time periods to show you where shipment statuses need to be updated (e.g., where an already received shipment is still marked as ordered) or to summarize...
where stock imbalances existed historically across all products in your database. The more accurate
the data in your data file, the better informed your decisionmaking can be.

**Excluding Suppliers from Your Reports**

Most reports in PipeLine have a feature called “Exclude Suppliers,” which enables you to
temporarily exclude shipments attributed to certain suppliers from the report data. (In PipeLine 4.0,
this feature was called “Exclude Selected”—wording has been updated to “Exclude Suppliers” in
PipeLine 5.1 to make the function clear.) See figure 23 for the location of the Exclude Suppliers
checkbox on the Stock Status Report screen.

**Figure 23. Location of the “Exclude Suppliers” Checkbox**

Why exclude suppliers? Many suppliers are not able to immediately commit to shipments during or
after the quantification. As a result, many shipments are often planned but “unfunded” for some
time. By using Exclude Suppliers, you can choose to temporarily remove the unfunded shipments
from your reports and demonstrate the impact on stocks if those shipments are not received. Some
programs create a supplier called “Unfunded” or “Unknown” to which uncommitted shipments are
assigned until they have guaranteed funding. Creating the “Unknown” or “Unfunded” supplier also
helps illustrate gaps in supply to potential donors and other stakeholders.

**Getting Data Out of PipeLine**

At some point, you may wish to analyze the data you have in PipeLine in an external program. While
you can always run PipeLine graphs or reports, these by themselves may not provide all the tools for
analysis that you desire. As it is programmed in Microsoft Access, PipeLine has built-in options for
exporting your data into other Microsoft Office programs, such as Excel and Word. You can also
open your PipeLine data file and directly copy data from it into another program, if you desire.
Procedures for getting your data out of PipeLine for analysis (either by exporting into another
Microsoft Office program or by copying it directly from the data file) are reviewed subsequently.

**Export to Microsoft Office Programs**

The most straightforward way to export data from PipeLine to other Microsoft Office programs is
available to you from each graph and report in PipeLine. To export, simply “Preview” the graph or
report you wish. At the top of the screen will be a menu item called “Office Links” (see figure 24).
Select the appropriate program (Word or Excel) for export from the Office Links menu.
Exporting Graphs

When you preview graphs in PipeLine, you do not have the same options as you do when previewing reports. There is no “Office Links” menu from which to export a graph into Word, for example. Your only option is to create a PDF, or portable document format. However, even in a PDF, there is still a way to extract the graph for use in a presentation (such as PowerPoint). Note that in order to perform this procedure, you need to have Adobe’s free Reader software on your computer. We suggest updating your version of Adobe Reader to the latest version before you try the following procedure.

1. Preview the graph you want to extract, and select the “PDF” button (see figure 25).

Figure 25. Location of the PDF Button

2. If you have never created a PDF from any program before, you will be asked to set a PDF writer (similar to selecting a printer from a list) and will be given a drop-down list of options. Select “Adobe PDF” from the list, or if you have an external PDF writer, such as deskPDF, select that instead.

3. Save your graph as a PDF file and open it in Adobe Reader.

4. Select Edit > Take a Snapshot. This enables you to select an area of the PDF to copy to the Windows clipboard, similar to copying and pasting text from a Word file (see figure 26).

---

2 Adobe Reader X was used to create these screenshots. The location of the Snapshot menu item may be different depending on your version of Adobe Reader.
5. Select the portion of the screen you wish to copy by holding down the left mouse button and dragging it until the entire image is selected in blue. When you release the mouse button, you will receive a confirmation message (see figure 27).
6. You can now paste the image into a Word document or PowerPoint presentation using Microsoft Office’s Paste function.

Note that you will not be able to manipulate the data underlying the graph through this procedure. You will only be able to copy and paste the graph as it appears on the screen. If you want to change how the graph looks, extract the data underlying the graph from the Access back end file, import it into Microsoft Excel, and then create the graph in Excel.

**The Program Data Export Function**

PipeLine has a menu item called Export Program Data in the Export drop-down menu. (A step-by-step guide to exporting program data is in *The PipeLine 4.0 User’s Guide*, page A-14.) This function creates an XML copy of all the data in the currently open PipeLine data file. It was originally programmed so that PipeLine data could be uploaded into a central database; however, the central database has not been built as of this writing. This XML could be used for importing data into another program if you desire and have the capability to design such an import. It is not possible to reimport it into another PipeLine database, however. The Program Data export function is not a backup mechanism for PipeLine databases. To backup your files, you can use the Copy procedure detailed in *The PipeLine 4.0 User’s Guide* on page 3-6 and discussed in the following.

**Copying Data from the Data File in Access**

It will rarely be necessary to open your databases outside of PipeLine to get to your data. Nearly all the data you need can be accessed in the reports and exported to Microsoft Excel or Word for manipulation. If you do need to copy data directly from the data file, follow these steps:

1. Back up your data first. Do not attempt to manipulate the data file in Access before backing up, as you can potentially lose your data.
2. Close PipeLine. Do not have PipeLine and Microsoft Access open at the same time.
3. Open the data file directly in Microsoft Access, and go to “Tables” to access your data.
Key Terms

Table 10 contains definitions of key terms used in PipeLine and referred to in this guide. In your program, you may define some of these terms differently; it is important to know how they are defined in the software both to understand how they interrelate and to make sense of them in the context of your own program. For a much larger list of Terms and Definitions, see Appendix B of *The PipeLine 4.0 User's Guide*.

**Table 10. Key Terms in PipeLine**

<table>
<thead>
<tr>
<th>Term</th>
<th>Used to…</th>
<th>PipeLine Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrived</td>
<td>Classify a shipment’s status</td>
<td>The product has arrived in country, but is not yet Received (e.g., not yet available for use by clients)</td>
</tr>
<tr>
<td>Average Monthly Consumption (AMC)</td>
<td>Calculate Stock in Months figure on Stock Status Reports</td>
<td>(Current month consumption + Future month 1 consumption + Future month 2 consumption) / 3</td>
</tr>
<tr>
<td>Couple-Year of Protection (CYP)</td>
<td>Calculate the number of couple-years of protection provided by a specific quantity of a contraceptive</td>
<td>The percentage used to calculate the amount of pregnancy protection afforded by a contraceptive product or method for one year. <em>This applies only to contraceptives.</em></td>
</tr>
<tr>
<td>Desired Stock Level</td>
<td>Automatically calculate the quantity of product to be ordered in each shipment, when using PipeLine’s shipment planning features</td>
<td>The upper limit (in months of stock) to which PipeLine’s shipments will be planned for a given product. Defined by the equation: (Max + Min + Order Interval) / 2</td>
</tr>
<tr>
<td>Funding Source</td>
<td>Describe a shipment</td>
<td>The entity providing the funds to purchase a particular shipment. The Funding Source may be the same or different than the Supplier of the shipment.</td>
</tr>
<tr>
<td>Months of Stock (MOS) or Stock in Months</td>
<td>Calculate how long your stocks will last as a function of consumption</td>
<td>Month’s ending balance / Average monthly consumption</td>
</tr>
</tbody>
</table>
Resources


## Appendix A: Error Messages

### Program Name and Code Conflicts in New Databases

<table>
<thead>
<tr>
<th>When It Occurs</th>
<th>Behavior</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are creating a new file with the same name or program code as an existing file (which is already open or has been opened on your machine).</td>
<td>You may not be able to return to the Program Data screen to fix the problem, even after clicking “OK” multiple times.</td>
<td>Close PipeLine entirely (using the Task Manager, if need be). Reopen PipeLine, and the error will be gone.</td>
</tr>
</tbody>
</table>

### Program Name and Code Conflicts in Existing Databases

![Error Message](image)
When It Occurs | Behavior | Solution
---|---|---
You are opening a file with the same name or program code as an existing file (which is already open or has been opened on your machine). | You will be unable to open the file. | Open the file in Microsoft Access, and edit the Program Code field in the “ProgramInfo” table. Change the Program Name and Program Code. This may wipe out the data in your Program Data screen, but it will not erase the rest of the data in the data file.

**Missing or Broken Reference in Microsoft Access**

When It Occurs | Behavior | Solution
---|---|---
You attempt to open a PipeLine data file in Microsoft Access to obtain data from the back end tables. | The error message persists after you click “OK” many times. | Continue to click “OK” and the error message will eventually resolve and allow you to open the data file in Access. You may see a message at the top of the Access screen that tells you some data have been blocked. Click “Enable Content” for maximum access to the data file.
Appendix B: Frequently Asked Questions

Does PipeLine Support Multiple Users?
PipeLine is a stand-alone application; it should be installed on each user’s computer. However, multiple users can share the data if the databases are stored on a shared drive or server. To do this, the shared drive or server should be selected when creating and saving a new file. Other computers connected to the shared drive can then select this file when opening a data file through PipeLine. It is possible to overwrite and undo another user’s changes, as there will be no indication that multiple users have a file open at the same time. Therefore, it is recommended that only one user update the data file at any given time; however, it is possible for multiple people to update the data file simultaneously. Please note that you may receive error messages pertaining to data collisions if multiple users update the files simultaneously. Also, all computers accessing the shared data file must be running the same application version. When upgrades are released, every computer must be upgraded.

Can I Import Data from Another Application?
PipeLine allows imports from XML files created from Quantimed, Supply Chain Manager, and other PipeLine databases. From Quantimed, PipeLine imports forecast consumption data. From other PipeLine databases, PipeLine imports shipment data. However, it is possible to import data from other sources if the XML file is designed to be accepted by PipeLine. If you want to design an XML file output from a specific application for import into PipeLine, see the XML schema found in the PipeLine 5.1 Technical Documentation (USAID | DELIVER PROJECT 2011b; available from the USAID | DELIVER PROJECT upon request).

Why Can’t I See Graphs?
PipeLine will run on Windows XP and above. However, a known bug in Windows Vista and Windows 7 platforms cause graphs to display incorrectly on the form. If you select a graph from the tree view and it is not displayed, select your report criteria, then click the Preview button to see the graph on the report. When you close the report, the graph will display on the form, but it may disappear again if you change criteria. Another option to see the graph on the form is to minimize PipeLine and then maximize it. This will cause the screen to refresh and display the graph. We are working to resolve this issue for a future PipeLine release.

Does PipeLine Track Expiration Dates of Products by Lot?
PipeLine is a tool for planning shipments on a programmatic basis and for tracking program-wide stock status. Expiry dates are usually tracked in an inventory management system, often by a warehouse management system. PipeLine is not a warehouse management system; therefore, it does not provide an easy way to track products by lots and expiry dates.

Will PipeLine Automatically Update My Shipment Status for Me?
PipeLine does not automatically update shipment status as time passes (i.e., it does not assume that a shipment has actually shipped just because the scheduled ship date has passed). You must manually change the status of a shipment (from “ordered” to “shipped,” for example), as confirmation of a change in status becomes available.
**Does PipeLine Warn Me if My Stocks are Out of Balance?**

PipeLine can provide information on out-of-balance stocks and needed actions for shipments through the tickler reports (PipeLine Action and PipeLine Problem). If you do not run these reports, however, you will not see a warning message from PipeLine stating that your supply chain is out of balance.
# Appendix C: PipeLine Help Request Form

Use this form to send a help request to the PipeLine help email (Pipelinehelp@jsi.com).

<table>
<thead>
<tr>
<th><strong>Your Name:</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Country (if applicable):</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Phone Number:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Email Address:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>PipeLine Version:</strong></td>
<td>(go to Help &gt; About PipeLine to see version number)</td>
</tr>
<tr>
<td><strong>Microsoft Office Version:</strong></td>
<td>(i.e., Office 2010, Office 2003, etc.)</td>
</tr>
<tr>
<td><strong>Operating System:</strong></td>
<td>(i.e., Windows 7 64-bit, Windows XP, etc.)</td>
</tr>
<tr>
<td><strong>Summary Information:</strong></td>
<td>(Summarize the problem in a short paragraph.)</td>
</tr>
<tr>
<td><strong>Steps to Reproduce Problem:</strong></td>
<td>(Write out the actions you perform in PipeLine to get the problem to reoccur.)</td>
</tr>
<tr>
<td><strong>Files Needed to Reproduce Problem, or Screenshots of Error:</strong></td>
<td>(List here any files included with your email that we will need to reproduce the error. Also list screenshots of the error message attached to your email.)</td>
</tr>
</tbody>
</table>
For more information, please visit deliver.jsi.com.